Remote Access for Siemens®
S7-300 & 400 PLCs, and their 
VIPA equivalents S300 - 
SPEED7.

This guide explains in a few steps how to configure your eWON, your Talk2M account and your PLC software to access your Siemens S7-300, S7-400 PLCs and their VIPA equivalents S300 - SPEED7 for remote diagnosis and programming.
Table of Contents

1. Hard- and software requirements ................................................................. 4
   1.1 Hardware requirements ........................................................................ 4
   1.2 Software requirements ........................................................................ 4
       1.2.1 eWON related software ............................................................... 4
       1.2.2 Siemens or VIPA related software ................................................ 4
   1.3 eWON Firmware Version ..................................................................... 4

2. Objective ....................................................................................................... 5

3. Typical configuration setup ......................................................................... 6

4. Prerequisite: Determining suitable IP addresses ....................................... 7
   4.1 Internet connection using the WAN Interface ....................................... 7
   4.2 Internet connection by modem (GSM, PSTN, ADSL) .......................... 8
   4.3 For proper routing, remember ............................................................. 8

5. Reaching your eWON through the Internet ............................................. 9
   5.1 Step 1: Setting IP address of eWON LAN .......................................... 9
   5.2 Step 2: Configure eWON for Internet connection ............................... 12
   5.3 Step 3: Creating the eWON in your Talk2M account ......................... 15
   5.4 Step 4: Getting the Talk2M activation key for the eWON ..................... 18
   5.5 Step 5: Configuring your eWON to connect to Talk2M ....................... 20
   5.6 Step 6: Connecting the eWON remotely ............................................. 23
   5.7 Step 7: Terminating the remote connection ....................................... 25

6. Linking eWON and PLC ........................................................................... 26
   6.1 Local link capabilities ......................................................................... 26
   6.2 MPI/Profibus link configuration ........................................................... 26
   6.3 Ethernet ISOTCP link configuration ..................................................... 29

7. PLC software mapping configuration ....................................................... 30
   7.1 Common steps for MPI and Ethernet ISOTCP link .............................. 30
   7.2 Additional steps for MPI local link only ............................................. 31

8. Establishing remote connection ................................................................. 40

9. Troubleshooting ......................................................................................... 41
   9.1 Cannot reach the PLC on its MPI/Profibus port? ................................. 41
   9.2 Cannot reach PLC by Ethernet ISOTCP ? .......................................... 41

10. Appendix 1 – Specifics for Modem connections .................................... 43
    10.1 General ............................................................................................ 43
    10.2 Configuring the eWON for Internet connection (Step 2) .................... 43
    10.3 Creating the eWON in your Talk2M account (Step 3) ....................... 45
    10.4 Connecting the eWON remotely (Step 6) .......................................... 45
    10.5 Terminating the remote connection (Step 7) .................................... 46

11. Appendix 2 – eWON as Gateway in PLC .............................................. 47
    11.1.1 Phase 1 – Communicating online with the PLC ......................... 47
    11.1.2 Phase 2 – Embedding the IP config in the PLC program ............... 49

12. Appendix 3 – Security aspects ................................................................. 54
    12.1 Login security .................................................................................. 54
    12.2 Traffic security ................................................................................. 54
1. Hard- and software requirements

1.1 Hardware requirements

In order to follow this guide you'll need:

- 1 eWON with VPN capabilities (for example eWON 2101CD with integrated modem or a 2005CD with second Ethernet interface)
- 1 Siemens PLC S7-300 or S7-400 Series or, 1 VIPA PLC S300-SPEED7 Series or equivalent both featuring MPI/Profibus and/or Ethernet ISOTCP interface
- PC suitable to configure the eWON and the PLC

1.2 Software requirements

1.2.1 eWON related software

- Web browser – Internet Exploreri or Firefoxii to configure the embedded eWON parameters.
- eBuddy – eWON detection and firmware maintenance utility
  http://support.ewon.biz/softwares.htm
- eCatcher – VPN tunneling utility
  http://support.ewon.biz/softwares.htm
  Note: this utility will be used to create the Talk2M account and to connect to your eWON remotely.

1.2.2 Siemens or VIPA related software

- SIMATIC Step7®iii software. The version of the SIMATIC Step7® software must allow the use of the TCP/IP interface (version 5.3 or higher).

  Note: for VIPA users, we assume the use in combination with SIMATIC Step7®. Achieving the same tasks in combination VIPA's software WinPLC7 is most probably feasible but not documented by eWON.

1.3 eWON Firmware Version

Successfully following these guidelines requires an eWON firmware version 6.1s2 or higher. The eBuddy application will allow you to upgrade your eWON firmware if required.
The objective of this document is to guide you through the steps required to enable remote access of your Siemens or VIPA PLCs.

The remote access setup is composed of 4 different parts:

- Communicating with your eWON through the Internet
- Connecting your eWON with your Siemens or VIPA PLC
- Configuring your Siemens software to correctly communicate through the eWON.
- Accessing your PLC through the Internet

To configure the eWON, all you need is a Web Browser and to open the internal Web page of the eWON. (http://10.0.0.53 is the default IP factory setting)

If you are connecting to an eWON for the first time, you should read the "Quick Start Guide for eWON" shipped with your eWON. This document explains step by step how to change the IP address of the eWON LAN port in order to be able to connect to it.
3. Typical configuration setup

Configuring remote access is simple. However, you will need to pay attention to the different IP ranges involved. The diagram below summarizes the different network ranges in use (IP numbers are examples).

When it is hooked on the Company LAN (or to the Site LAN) the configuration PC needs to be configured in DHCP-enabled mode for you to be able to go through the steps involving the general Ethernet/Internet infrastructure.

When it is hooked to the LAN-port of the eWON and the configuration PC needs to be configured with a fixed IP address - in the eWON LAN range - for you to be able to go through the steps involving the eWON (and the Ethernet ISOTCP connected PLCs).

**Note 1:** Because iterations between IP ranges are necessary during the configuration process, you could consider using 2 different configuration PCs. It is no problem if you use only one single PC, the present guide mentions each change in IP configuration that will be required.

**Note 2:** As the picture above shows, under normal circumstances the PC you will use to remotely access your eWON and PLCs will be on a different network than the site network. However, during configuration and testing, connecting PC to the site LAN is fine. As long as the site LAN address range is different than the eWON LAN address range you will not have routing issues.
4. Prerequisite: Determining suitable IP addresses

To avoid routing problems later, it is better to start to configure the eWON and the PLC with LAN IP addresses that will be suitable.

The type of physical carrier (GPRS or WAN/LAN) your eWON will use to connect to the Internet will have an impact on your IP address selection.

Before starting the actual configuration, please read the general principles below.

4.1 Internet connection using the WAN Interface

If you plan to connect to the Internet using the WAN interface, the eWON will require a LAN IP address at the PLC side and a WAN IP address at the network side.

Example of IP ranges involved in a WAN/LAN configuration:

**Important Note:** The company network address ranges (Company LAN and Site LAN in the example above) are specified and managed by the respective network administrators. These ranges simply cannot be changed. So before configuring your eWON LAN IP address and your PLC IP addresses, please ask for:

1. The specified company LAN network range to be used by the PC that will initiate the remote connection (Company LAN).
   
   In our example this range is 10.0.0.#

2. The specified company LAN network (Site LAN) range (and gateway) which the eWON WAN port will use to get Internet connection.

   In our example this range is 10.10.0.#

Knowing the ranges in use at the Company and Site side, you will be able to select a range **outside** these networks for the eWON LAN-port and the PLC.

In the above example, we could select addresses in the 192.168.0.# IP range for the eWON LAN and PLC since it does not overlap neither with the Company LAN range nor with the Site LAN range.
4. Prerequisite: Determining suitable IP addresses

4.2 Internet connection by modem (GSM, PSTN, ADSL)

If you plan to connect to the Internet through a modem, you only need to select an IP address for the eWON LAN side. The IP address of the eWON LAN interface must be compatible with the IP address of the PLC, but be outside the network address space to which your PC is connected (Company LAN). If there is an overlap between the IP range of your PC and the IP-range of the eWON and the PLC LAN, the setup will not route correctly.

Example of IP ranges involved in a GPRS/Edge modem configuration:

4.3 For proper routing, remember...

1. The eWON LAN IP address must be part of the same IP range as the PLC LAN.
2. The eWON WAN and LAN IP addresses must be in different IP ranges. The WAN port of the eWON is generally DHCP-enabled, which is a good way to make sure that it will be compatible with the company network.
3. The remote PLC network (eWON LAN) must be in a different IP range than the company network on which your PC is connected (Company LAN).

Network 3 = eWON LAN = PLC LAN (all in same range).
Network 3 ≠ Network 2
Network 3 ≠ Network 1
5. Reaching your eWON through the Internet

5.1 Step 1: Setting IP address of eWON LAN

Once you have selected your IP addresses, you can start configuring your eWON. In our example, we will change the default factory address 10.0.0.53 to 192.168.0.53.

To configure your eWON LAN IP:

1. This connection will usually be made through the Company network. It can also be made with a point-to-point link. At this stage there is no constraint on the IP range of your PC. For this step, eBuddy can access the eWON even if your PC and the eWON have different network address ranges. eBuddy – eWON detection and firmware maintenance utility http://support.ewon.biz/softwares.htm

   ![Company LAN Connection](image)

   Connection through company LAN

   ![Point-to-point connection](image)

   Point-to-point connection
   (if eWON model has only 1 LAN port use crossed cable).

2. Start the eBuddy utility on your PC
5. Reaching your eWON through the Internet

3. In the home page, select **Set IP Address**

4. You don't need to fill out the **Serial Number**, just click on **Browse**

   eBuddy finds your eWON. Select it by double-clicking on it and the IP Address window opens.

5. Enter new LAN IP address and Subnet Mask. Click **Next**
5. Reaching your eWON through the Internet

6. Wait until address update and device reboot are completed. Click **Finish**.

   ![IP Address Wizard](image)

   In our example the eWON was set to LAN IP address 192.168.0.53. As shown below, this address fits into the PLC-range and does not interfere with the Company LAN.

   ![Network Diagram](image)

7. End of step 1
5.2 Step 2: Configure eWON for Internet connection

To configure your eWON’s Internet connection:

1. Configure the network parameters of your configuration PC to encompass the IP range of the eWON LAN. To do this, go to START, Settings, Network Connections. Open the currently used connection, select the TCP/IP parameter row and select a fixed IP address within the range of the eWON LAN. Click OK to close the wizard.

2. Connect the PC to one of the LAN ports of the eWON.

3. Open your Internet browser and access the eWON internal Web page by typing the LAN address you just configured (in our example http://192.168.0.53)

4. To open the eWON wizard page, click on Configuration in the toolbar and then on the wizard icon. The following page will be displayed:

5. Click on the icon next to Configure INTERNET Connection to launch the wizard. Following window will be displayed (options in drop down are depending on hardware configuration):
5. Reaching your eWON through the Internet

6. According to your eWON type (with a modem or a second Ethernet interface), you will have the possibility to choose between different connections:

- **Modem Connection**
- **Ethernet WAN** connection
- **ADSL**

*WAN refers to wide area network, which is network that covers a broad external area using the Internet infrastructure, as opposed to LAN referring to local area network that is restricted to internal networks.

From the next step onwards, we will address the most current access which is Ethernet WAN connection (for modem connection refer to Appendix 1 – Specifics for Modem connections).

7. Make sure the WAN port of the eWON is physically connected with the company network. **Traffic LED do not lit yet as the connection is not yet defined.**

8. Select **Ethernet WAN connection**. The usual configuration for Ethernet is DHCP enabled (device obtains IP address and Internet access automatically from host). Use a fixed IP address, Gateway and DNS only if this is clearly required by the network admin.
9. Click **Next** and go to step 10 **Internet Connection Test**.

10. The last step of the Internet configuration consist in a communication test. This test should end up successfully as shown in the snapshot below:

   ![Internet Connection Test](image)

   **The Internet Connection** means that the eWON is correctly configured for an Internet connection. If this test is not successful, then go back to the previous configuration steps and recheck all settings for **compatibility and accuracy**.

   The **Online IP Check** means that the eWON was actually able to reach an IP address on Internet. **It might not be so critical if this particular test fails**. Go ahead with the procedure without being too much concerned.

   You normally do not need to read this manual to complete the present procedure, but we mention for reference the detailed document describing the use of the wizard: AUG-019-0-EN-(eWON Configuration for Internet Access Using the Wizard). [http://support.ewon.biz/docs/Talk2M_Free.htm](http://support.ewon.biz/docs/Talk2M_Free.htm)

5. Reaching your eWON through the Internet

5.3 Step 3: Creating the eWON in your Talk2M account

To connect to your eWON remotely, we will use eCatcher and Talk2M.

1. You can skip the present point if you already created a Talk2M account. If you haven't created your Talk2M account yet, install eCatcher and create your Talk2M account as per § 3 of the guide "Talk2M – Getting started on Service Free+" available at http://support.ewon.biz/docs/Talk2M_Free.htm. You can download eCatcher from this link as well.

2. Connect your configuration PC to the company LAN and configure its network parameters to DHCP enabled (acquiring an IP address automatically).

3. On the menu on the left side of the eCatcher interface click on the "+" (New eWON) icon in the eWON list section. The following window appears:

![Image of eCatcher interface](image)

4. Enter the **eWON name** you want to use on the Talk2M server to identify the remote connection to your eWON.

5. The **eWON Serial Number** can be left empty. It will be encoded automatically during the Talk2M connection configuration of the eWON.

6. Select the **Connection Type** to specify how your eWON will be connected to the Talk2M server using:
   - a **LAN/ADSL** connection
   - a **GPRS/EDGE** connection or
   - an Internet connection over a **PSTN** connection (analog modem).

   If you specify a GPRS/Edge connection, then you will be asked to specify the phone number. This will allow Talk2M to **wake up your eWON remotely** using a Wake-Up SMS as described in Appendix 1 – Specifics for Modem connections.
5. Reaching your eWON through the Internet

Click on **Next**.

In older versions, you were asked to specify the **Remote Network** to reach behind the eWON like shown below. Since firmware version 6.2s0, when launching the eWON Talk2M wizard to enter the Talk2M-key, the wizard transfers the eWON LAN IP address to Talk2M automatically. In this case, this step is skipped.

![Remote Network Configuration](image)

In this case, the Remote Network configuration is acquired automatically.

7. Click on **Next**.

![Custom Fields](image)

Here you can enter additional information concerning your remote connection. The **Custom Fields** can be used to classify or filter your different remote connections. This will allow you to find easily the eWON you need to connect to.
5. Reaching your eWON through the Internet

8. Click on Finish to add the eWON to the eWON list of your Talk2M account.

   The new eWON account will now be displayed in the eWON List section on the lower part of the window.

5.4 Step 4: Getting the Talk2M activation key for the eWON

Up to now we only added the eWON on our Talk2M account, but we did not yet configure the eWON to connect to the Talk2M server.

To enable the eWON connecting to the Talk2M server, an activation key is needed. This key will allow the eWON to get back the VPN keys and certificates needed for the VPN connection. This step still uses the DHCP-enabled configuration of the previous step.

To get the activation key, proceed as follows:

1. Select the eWON in the eWON list and click on the Detail button.

The eWON Detail window opens.

2. Click on the eWON Setup button.
5. Reaching your eWON through the Internet

The following window opens:

3. Under the **Configure via Activation Key** section you will find the Activation Key needed for the eWON configuration. Click on the **Copy** icon to copy the activation key into the clipboard of your PC. Keep this information on your clipboard to complete Step 5: Configuring your eWON to connect to Talk2M (go to this step).

Note: Using the Activation Key is the standard procedure. Next to this method, there are 2 alternative methods:

- **Configure via eWON Name**: During the eWON Talk2M wizard, instead of using the Activation Key you can alternatively specify the **eWON Name** and use the user name and password of your Free+ account.

- **Configure via SMS**: If your eWON has a GSM modem and if the eWON is already configured for Internet connection, then you can also send an SMS to the eWON containing the activation key. When eWON receives the SMS, it will then trigger automatically the Talk2M connection wizard and will configure itself to connect to the Talk2M server.

5. Reaching your eWON through the Internet

5.5 Step 5: Configuring your eWON to connect to Talk2M

1. Configure the network parameters of your configuration PC to encompass the IP range you used to allocate the LAN IP address to the eWON.

2. Connect the PC to one of the LAN ports of the eWON.

3. Open your Internet browser and access its internal Web page by typing the LAN address you just configured (in our example http://192.168.0.53)

4. To open the eWON wizard page, click on Configuration in the toolbar and then on the Wizard icon.

   The wizard window will open:

5. Click on the Talk2M wizard.

   The following window will be displayed:
6. Click on **Next** to register the eWON on the Talk2M server.

7. Click on **Register with ACTIVATION KEY**, as in the previous step, we copied the Activation Key to the clipboard of your PC. Paste the Activation Key (Ctrl+V).

8. Click **Next**

   **Note**: If you choose the **Registration with eWON NAME** method, then you will be asked to enter the Name you specified for the remote connection in your Talk2M account. You will also need to specify your Talk2M account name and enter the user name and the password which you use to connect to your Talk2M account.

   The next window of the wizard will ask you if you need to connect through a Proxy server.

9. Check this option only if you need to specify a Proxy server for the Internet connection. Otherwise leave this option unchecked and click **Next**.
10. The Talk2M registration will now start and the result will be displayed on the wizard page:

The eWON will first test the different connections needed to connect to the Talk2M server (UDP and HTTP or HTTP using a Proxy). Then the eWON will connect to the Talk2M server and retrieve the VPN keys. At the end, the eWON will establish the VPN connection to the Talk2M server.

Once the registration and configuration of the eWON are completed, the result will be displayed on the Wizard page as shown in the following picture:

11. Click on the **Done** button to close the wizard.
Your eWON is now configured to connect to the Talk2M server.

5.6 Step 6: Connecting the eWON remotely

Now that the eWON is configured to connect to Talk2M, we can establish the remote connection to the eWON.

1. Connect your configuration PC to the company LAN and configure its network parameters to DHCP enabled (acquiring an IP address automatically).
2. Launch eCatcher and open your Talk2M account.
3. In the eWON list section select the eWON you want to use for the remote connection.

The eWON which you just configured should now be displayed as on line (green tick in the action column). This means that the eWON has established its VPN connection to the Talk2M server.

4. Double-click the online icon or click on the Connect button displayed in the eWON list menu to establish the remote connection to this eWON. eCatcher will now establish the VPN connection to the Talk2M server.

5. Once the VPN connection to the eWON is established, the eWON will be displayed in the Active connection section on the top of the window.
5. Reaching your eWON through the Internet

6. The PC is now connected to the eWON using the VPN tunnel and you can start to use the remote connection.

7. If you want/need to connect to the eWON itself, you can click on the IP address link in the **Active Connection** section, as displayed in the following picture. Once the home page of the eWON web interface is displayed, you know for sure that your connection is effective.

![Active Connection](image)

**Note**: For specifics related to modem connection (including GPRS/Edge) please go to § 10 Appendix 1 – Specifics for Modem connections at the end of this guide.

5. Reaching your eWON through the Internet

5.7 Step 7: Terminating the remote connection

1. Click on the disconnect button in the Active connection section. This will close the VPN connection with the eWON.

2. **Note**: For specifics related to modem connection (including GPRS/Edge) please go to § 10 Appendix 1 – Specifics for Modem connections at the end of this guide.

6. Linking eWON and PLC

6.1 Local link capabilities

Depending on whether the PLC will be connected to the eWON with a MPI/Profibus or Ethernet ISOTCP link, the eWON configuration and the connection to the PLC will be different. Both types of connections will be explained.

Keep in mind that you can combine both connection types without any problem. For example, you can connect at the same time to one or more S7-300&400 using the MPI/Profibus port of the eWON and connect to one or more S7-300&400 PLC(s) using the Ethernet ISOTCP connection between the eWON and the PLC.

6.2 MPI/Profibus link configuration

1. Go to the eWON Web page either using the just configured VPN tunnel or a point-to-point connection to the eWON LAN port.
2. Open the eWON IO Server configuration and go to the IOServer page
6. Linking eWON and PLC

3. In the drop down field select the "S73&400" IO Server

4. Set the Protocol Type, Baud Rate, Reply Timeout, and MPI/Profibus Highest Station Address corresponding to those actually configured in the PLC you want to communicate with (shown values are eWONs default values):

Note: The MPI/Profibus Address is the MPI address of the eWON not the one of the PLC! The address configured here has to be an MPI Address that is not yet used on the MPI network. In most cases the default value 0 will work fine.

5. Save your settings by clicking on Update Config and leave the Web configuration interface open.
6. Linking eWON and PLC

6. Interconnect the MPI port of the eWON with your PLC

7. Go back to IOServer settings page (Edit menu) and click on the **Destination MPI Node link** to check if the eWON MPI interface is correctly configured and connected to your MPI network.

8. The **MPI Status Info** popup opens:

   ![MPI Status Info](image)

   This window will show you the different MPI devices detected by the MPI chip of the eWON. The ID numbers of the detected MPI/Profibus master devices are highlighted.

   If the status table does not display any MPI address, then the MPI IOServer setup parameters for your eWON are not correct (or have not been saved using the **Update Config** button). Please check the baud rate settings, verify that the eWON is not using an already used MPI address and make sure you end-up with **Update Config**.

   If the status table displays only one MPI address (actually the one of your eWON), it is likely that the Baud Rate settings are not correct or that the eWON is not properly connected to the MPI network (or that the cable used is not OK).

9. End of serial link configuration.
6. Linking eWON and PLC

6.3 Ethernet ISOTCP link configuration

1. If your eWON runs a firmware 6.2s1 or greater (see note) AND your application is straightforward, there is nothing to do but making sure that the PLC IP address is in the same range than the LAN IP of the eWON.

**Note 1:** From eWON firmware version 6.2s1 onwards, the Plug’nRoute function automatically configures the Ethernet routing. With this configuration, it is - in most cases - no longer necessary to set the eWON address as Gateway into the PLC.

If, for any reason, you are using an earlier firmware version (not recommended) OR would the Plugn’Route function not work in your specific application, then you should refer to Appendix 2 – eWON as Gateway in PLC.

**Note 2:** The eWON types with 4 LAN ports (2005CD or 4005CD) can be connected to the Ethernet port of the PLC directly. Whereas the eWON types with a single LAN port (2101CD or 4101CD) need to be connected with a crossed cable (single PLC) or an external switch (multiple PLC).

2. End of Ethernet link configuration.
7. PLC software mapping configuration

7.1 Common steps for MPI and Ethernet ISOTCP link

1. Start SIMATIC Step7® and open your existing or new PLC project. Select Options, Set PG/PC Interface...

2. Select the TCP/IP interface that you are using on your PC and click OK. In the first example below we chose the TCP/IP(Auto) interface, but depending on your machine, you might have to select TCP/IP(Auto) →+ hardware identifier (2d example).
3. Click on the Properties... button to show up the properties of the selected interface. Open the **IE-PG Access** tab and select **Do not assign IP addresses automatically**.

4. Click **OK** to close the properties page. Back on the **Set PG/PC Interface** window, click **OK** to set the PC/PG interface.

5. Click **OK** to accept the changes.

### 7.2 Additional steps for MPI local link only

If you use an Ethernet connection between the eWON and your PLC, then the PLC software mapping configuration ends here. You can directly establish the remote connection as explained in the chapter 8.

If you connect to the PLC using the MPI or Profibus link, then follow the steps explained hereunder:

6. Download one of the following config files from our support web site ([http://support.ewon.biz/ewon_cfg.htm](http://support.ewon.biz/ewon_cfg.htm)).

   - **eWON.cfg** - eWON gateway station file for Step7® if you run SIMATIC on a PC that does not feature WinCC.
   - **eWON_WinCC.cfg** - eWON gateway station file for Step7® (with WinCC installed) if you run SIMATIC on a PC that features WinCC.
7. Open the Network Configuration **NetPro** utility of your Step7® project.

You can access NetPro either by clicking the icon....

... or by selecting the menu options **Options → Configure Network**...

you obtain the NetPro network layout window shown below:

8. Import the eWON gateway station file you downloaded just before. Access path is **Edit and Import**. Browse to select either the eWON.cfg file (without WinCC) or eWON_WinCC.cfg (with WinCC) and click **OK**.
Note: the **Export file to a station** needs to be selected, though the notion of export is confusing while you will actually be importing a device configuration.
9. The eWON gateway will now be displayed in your network layout:

Note: If you have problems importing one of the config files, refer to appendix 1 of Technote 29 explaining how to create the eWON gateway station file for Step7® with NetPro from scratch.

10. Click on the red square of the eWON and drag it to the MPI network of your S7 PLC to link the MPI interface of the eWON to the MPI network.

11. Open the MPI interface of the eWON by a double-click on the red square and check if the MPI address, the transmission rate and the Subnet-ID are correctly set. (Use the Properties... button for more details). Click OK twice to close the two Properties windows.
12. Double-click on the green square of the eWON to configure the Ethernet Interface of the Gateway.

As shown in the snapshot, do not check **Set MAC address / use ISO protocol**.

In the **IP address** field, enter the IP address of the eWON which will be used for the remote connection (in our example 192.168.0.53). For the **Subnet mask** enter the mask corresponding to the IP address you specified for the eWON (in our example 255.255.0.0).

**Note**: In some cases Step7 rejects Subnet masks he finds inconsistent and forces you to accept for example 255.255.0.0: you can accept while it will not harm the connection capability.

If you want, you can edit the name of the Ethernet by clicking **Properties**. Click **OK** twice to close the two Properties windows.
13. You will now add a PG/PC Station to the network layout using the path **Insert → Network Objects** of NetPro. Double-click on the PG/PC Station. An unconnected PG/PC station is now added in the network pane:

14. Right click the PG/PC and click on **Object Properties...** and select the Interfaces tab and click **New**.
15. Select **Industrial Ethernet**, and click **OK**.

16. In the parameter tab, make sure the **Set MAC address / use ISO protocol** is NOT selected. - Set the **IP address** and the **subnet mask** of your PC. Check the **Do not use router** box. In the Subnet window on the bottom of the page select the network on which the eWON is connected to: in our example we named it **eWON Gateway Ethernet**. Click **OK** twice to close the two Properties windows.

17. Your network layout should now look like this:
18. You will now have to assign the PG/PC interface. To do this, right click the PG/PC picture and click on Assign PG/PC.

19. The Assignment tab of the Properties -PG/PC wizard appears:

In the Interface Parameter Assignments in the PG/PC select the TCP/IP interface you are using to connect to the Ethernet. In our example it is TCP/IP(Auto), needs to be consistent with point 3 above. Click the Assign button.

**Note:** in some cases, the message shown on the right may be displayed:

*You can Ignore this message and click OK.*
20. Verify that the **Assigned** Interface is the Ethernet card and click **OK**. Your network layout is now looking like this:

![Diagram of network layout](image)

**Note:** The yellow link on top of the PG/PC shows that this object will be used to go out on the network. The orange background behind the other objects are meant to warn the user that his last changes have not been saved and compiled yet.

21. You will now have to compile and save the network layout of your project. This is achieved by following the **Network → Save and Compile...** path in NetPro.

![Diagram of saving and compiling](image)
22. Select **Compile and check everything** if you want to have NetPro reporting errors (recommended if this is your first experience). You can select **Compile changes only** if you feel confident that everything is alright. Click **OK**.

23. After compilation a popup will be displayed to inform you if the compilation was done with success or not. **Warning** messages are informative only and may usually be discarded. Only **error** messages reflect real network configuration problems.

24. The network layout of your project should now looks like this:

![Network Layout Image]

25. You can close the NetPro window

26. End of PLC software mapping configuration
8. Establishing remote connection

It is supposed you have been going through the previous steps. Hence, your PLC and the eWON are physically connected either by MPI or by Ethernet ISOTCP connection. The steps below are the same for both connection type.

1. First establish the remote connection to the eWON as explained in Step 6 of the eWON configuration part.

2. Once the Talk2M VPN tunnel towards the eWON is established by eCatcher, start SIMATIC STEP7®

3. Open your project and make sure you can connect with the PLC by running one of the tasks requiring communication like for example, right click on the CPU in the object tree, select PLC > Set Time of Day.

4. Now you can check that the actual date/time returned by the PLC internal clock. (under Module time). If the connection is OK, this date/time should be incrementing.

5. Your setup is now connected and ready to work in remote programming mode. Once you finished your work with SIMATIC STEP7®...
   - ...terminate the SIMATIC Step7® connection through View > Offline and close the application.
   - ...terminate the Talk2M connection of the eWON explained in Step 7: Terminating the remote connection of the eWON configuration part.

6. End of PLC remote access.
9. Troubleshooting

9.1 Cannot reach the PLC on its MPI/Profibus port?

If you cannot reach the serial PLC connected to the eWON then verify the following:

- Check **IOServer configuration** in eWON page (S73&400 and protocol settings)
- Open the eWON Event Log [Main Menu, Diagnostic, Event Log] to check for error messages.
- In SIMATIC Step7® check in the Netpro network layout if the correct IP address has been configured: You must use either the eWON LAN IP address or the eWON VPN IP address.

9.2 Cannot reach PLC by Ethernet ISOTCP ?

To be able to reach the PLC by Ethernet ISOTCP, the following conditions must be fulfilled:

- Reboot the PLC after IP address and/or gateway change.
- Check that the network LEDs are lighting at both ends. If they aren't, it means there is an issue with the Ethernet cable(s). If you use an eWON having a single Ethernet LAN port (no integrated switch), then you have to use either a **crossed** Ethernet cable (point-to-point with single PLC) or an intermediate switch (multiple PLCs).
- You might have a mismatch between the actual IP configuration of the eWON and the eWON LAN IP address configured as Remote Network in your Talk2M account. You can check, and if necessary, modify these settings, in eCatcher. Under the eWON list select the Name of the remote connection and click on the **Detail** button.

The eWON Detail window will open:

Here you will find the different information you entered earlier. The Remote Network is specified under the Remote connection section.
9. Troubleshooting

To change the Remote Connection settings, click on the Edit button on the top of the page.

Once the modification is finished, click on the Save button which is displayed on the top of the window when in edit mode. After the change you would then have to save and Disconnect and Connect the VPN bridge to the eWON for Talk2M to take the modification into account.

- The remote PLC network must be in a different range than the company network on which your PC is connected (see Step 1: Setting IP address of eWON LAN).
10. Appendix 1 – Specifics for Modem connections

10.1 General

The basic configuration principles remain the same except for typical modem settings. Allow enough time for tasks to be executed when you use a modem link.

In the following explanations, we took the most current example of GPRS/Edge modem. Extrapolating to other modem technologies is rather straightforward.

Only those steps that are different from the LAN/WAN connection are addressed.

10.2 Configuring the eWON for Internet connection (Step 2)

1. In the Internet configuration wizard of the eWON, select **Modem Connection** option and, depending on the modem installed in the eWON, the interface asks the user to fill out the different parameters of the relevant modem. Fill out the different fields (PIN code, APN and user name/password) according to those you received from your Service Provider. For most Service Providers, User Name and Password can be left empty. Click **Next**.

2. Configure how the eWON should go online, and click **Next**.
In most cases, it will be **Triggered by outgoing actions**. This option is needed to be able to use the Wake-Up function. Only check **Maintain connection** if you want to use a permanent connection to your eWON device (which can be very expensive using a GPRS/Edge line).

3. Configure your online time parameters, and click **Next**

In most cases, you can leave the default parameters.

The **Max outgoing call duration** is set by default to 60 minutes. The eWON will drop the Talk2M connection after 1 hour. If you need longer connection times, enter a higher value or set it to 0 for no limit.

By default, the **Idle time before hanging up** is set to 120 seconds. You can leave this value as is. In fact, it is not a useful parameter for a Talk2M connection because a VPN life bit is periodically exchanged preventing connection interruptions due to idle times.

4. **End of Step 2 in Appendix 1.**
10.3 Creating the eWON in your Talk2M account (Step 3)

1. In the creation process of the eWON in your Talk2M account, the sole additional steps are:
   - specifying the connection type (in our example GPRS/Edge)
   - entering the phone number

2. End of Step 3 in Appendix 1.

10.4 Connecting the eWON remotely (Step 6)

1. If you use an eWON GPRS, then you probably configured the eWON not to stay connected all the time to the Talk2M server. Before being able to connect to the eWON over Talk2M you will first need to wake-up the modem of the eWON. To do this, click on the **Wake-up** icon in front of the eWON name as shown in the following picture:
2. Talk2M sends an SMS (text message) to the eWON to ask the eWON to start its Internet connection and to connect to the Talk2M server. This can take up to several minutes; do not interfere until this process is completed.

Note: You do not necessarily need Talk2M to send the wake-up SMS to the eWON. You can do this using your own GSM (cellular phone). All you need is to have the dial number of the eWON by the hand and to send the following SMS (text-message) to it: [Talk2MConnect] (without brackets).

3. Once the modem is online, the green Connect icon is shown to allow to bridge the VPN tunnel.

4. You can now click on the Connect button as explained in the LAN/WAN procedure to establish the remote connection.

5. Once the VPN tunnel is bridged the red Disconnect icon is shown to allow you to cut the bridge of the VPN connection.


10.5 Terminating the remote connection (Step 7)

If the eWON to which you were connected uses a Modem connection for the Internet access, then you probably want to close the Internet connection of the eWON (to save GPRS communication costs). This is done with eCatcher.

Note that there are 2 distinct notions to be considered: Connect / Disconnect that applies to bridging the VPN tunnel and Go Offline that closes the VPN link and hence the modem connection (on hook)

1. Click on Disconnect to cut the VPN bridge.

2. Right-click on the Online icon in front of the eWON. In the context menu click on the Go offline button to send the disconnect request to the eWON. The eWON will then close its Internet connection and after a while the eWON will be displayed as offline in your Talk2M account.

3. End of Step 7 in Appendix 1.
Appendix 2 – eWON as Gateway in PLC

Chapter 11.

11. Appendix 2 – eWON as Gateway in PLC

If, for any reason, the Plug’nRoute function is not working in your configuration, then you will need to disable the Plug’nRoute feature in the eWON and configure manually the eWON LAN IP address as default Gateway in the configuration of the PLC.

3. To disable the Plug’nRoute function, connect to the eWON web site and click on Configuration, System Setup from the Main Menu. Navigate further to Communication, Networking Config, Routing and the screen below should be displayed:

Select NAT and TF disabled from the drop-down menu in the Apply NAT and TF to connection click Update AND reboot the eWON.

There are two phases to configure the IP addresses in a Siemens or VIPA PLCs:

Phase 1 consists in allocating the new IP addresses to the hardware to enable communication with the PLC. This configuration is volatile and would be lost in case of PLC reboot or power down. Phase 1 is done by connecting the Ethernet card to your company network and having SIMATIC Step7® on your PG/PC detecting the IP-address of the card to be able to edit its configuration.

Phase 2 consists in configuring the new IP address in the project on the PG/PC side and downloading the project (featuring the new IP address) to the PLC.

Note: Alternatively, you can download the Ethernet card configuration parameters using a point-to-point MPI link between your PG/PC and your PLC.

11.1.1 Phase 1 – Communicating online with the PLC

1. Connect the Ethernet card of the PLC with the company network to which the configuration PG/PC is also connected.
2. Start SIMATIC Step7®, open your project and PLC > Edit Ethernet Node... from the main menu.
3. In the Edit Ethernet Node wizard, click on the Browse button to have SIMATIC Step7® searching for the connected Ethernet PLC-nodes on the network. Select the node you want to configure from the proposed list:
4. Enter the **IP address** and **Subnet Mask** of the PLC (has to be in same range than the eWON LAN), tick the **Use Router** button and enter the eWON LAN address as Gateway. Do not forget to click on **Assign IP Configuration** to send the change to the PLC. Wait for the success message and click on **Close** when you have finished.
11. Appendix 2 – eWON as Gateway in PLC

5. To test the Ethernet communication, you need to put your PG/PC in the same IP range than the PLC, otherwise you will not be able to connect. Right-click on the CPU node, select **PLC > Set Time of Day**. If the **Set Time of Day** panel appears and timers are incrementing, the communication is working alright. If not, check PG/PC IP range and whether the new IP config in the PLC was retained. **Do not** power off or reset the PLC until the new configuration will embedded in the PLC program (phase 2).

11.1.2 Phase 2 – Embedding the IP config in the PLC program

**Note:** It might seem strange but, you have to redo in another environment part of the job you did in Phase 1. This time it is to embed the new IP configuration into the PLC program and to make it persistent (no longer temporary and sensitive to power off or reset).

1. On your project, select your PLC-station object in the tree, right-click and select the **Open Object** menu option like shown below:

2. This opens the hardware configuration window shown below. Open the Ethernet card properties by double-clicking it in the slot table. In the wizard click on **Properties**.
3. Enter the **IP address** and **Subnet Mask** of the PLC (has to be in same range than the eWON LAN), select the **Use Router** option and enter the eWON LAN address as Gateway. You can leave the Subnet as **not networked**. Click **OK**.

4. You can click **OK** on the error message stating the module is not assigned to a network.
5. Save your changes by clicking **Station > Save and Compile**. Wait until the operation is completed. Once OK the new IP config is included into the project program on the PG/PC-station, but has not yet been sent to the PLC!

6. Download the program integrating the new IP config to the PLC module by clicking on the **PLC > Download** menu items. Check the CPU module and click **OK**.

7. The interface opens a node selection pane, select the node of the Ethernet card meant to interface with the eWON and click **OK**.
8. A warning states that the CPU will be stopped during the download: make sure this is not likely to bring any process or person in danger and click OK. When the download is completed, another warning asks whether the CPU should be restarted, click Yes.

9. If you want to make sure your parameters are well stored, power the PLC off and on again and check that its new IP config is well maintained (SIMATIC Step7® main menu PLC > Edit Ethernet Node > Browse).

10. You can now make the physical link between the PLC to the Ethernet LAN port of the eWON.

11. End of Ethernet ISOTCP link configuration.

What if you cannot set Gateway on PLC?

Setting the eWON as Gateway in the PLC is not always possible. In such case, you should first make sure the Plug’nRoute feature does not work in your specific case. Disable Plug’nRoute like explained in point 1 above and reboot your eWON.

You can now use the eWON Proxy feature to allow remote connection to the PLC without mapping the eWON IP address as gateway.

Detailed information on how to do this can be found on the eWON Web site: "How to proxy a PLC protocol" http://support.ewon.biz/docs/Proxy_PLC.htm

When using a Proxy, in combination with a Talk2M Connection, then you need to map the VPN IP address of the eWON in SIMATIC Step7 to allow the remote connection.
This is impacting:

§ 5.6 Step 6: Connecting the eWON remotely - point 5 – you need to fetch the VPN IP address allocated by Talk2M. Keep only the core IP, not the port part, this would be 10.8.129.82 in the example below.

§ 6 Linking eWON and PLC – you need to configure the proxy feature of the eWON. See detailed description in document referenced above.

§ 7 PLC software mapping configuration – you need to map the VPN IP address instead of the eWON LAN IP address.

§ 8 Establishing remote connection – point 4 – The PLC appears in the list with IP address of the VPN (not its own IP address).
12. Appendix 3 – Security aspects

12.1 Login security

A good security practice consists in modifying the login and password of the default super user adm/adm (this default super user cannot be deleted). Modifying the default super user is done by clicking on **Configuration, Users Setup** button on the main menu of the eWON web page.

12.2 Traffic security

Since the eWON firmware version 6.2s1 (see note), when the Talk2M wizard is executed, the WAN Security setting is set automatically to **Discard all traffic excepted VPN and initiated traffic**. This is preventing third party traffic to interact with your private traffic.

If, for any reason, your eWON runs an earlier firmware version (not recommended) OR that you want to check the WAN protection status, you can do it using the following path: **Configuration, System Setup, Communication, Networking Config, Security**.

Check that the **Discard all traffic excepted VPN and initiated traffic** check-box is ticked.

If the eWON is configured to use a modem to go out on the Internet, then the WAN connection is the GPRS/EDGE connection. **This type of access definitely requires protection.** If the eWON is configured to use its second Ethernet Interface to go out on the Internet, then the WAN connection is the Ethernet WAN port that uses the company infrastructure and benefits from the IT protections in place. Hence, this type of access is less exposed to security issues.

**Note:** The changes applied on this page will only be effective from the next WAN connection. So from the next GPRS connection, or after an eWON reboot if you use the 2nd Ethernet port of the eWON for the Internet connection.
13. Appendix 4 – MPI/Profibus cable

The MPI/Profibus cable you can use the standard Siemens Profibus cables and connectors.

Siemens is offering a range of different MPI cable references we cannot list here.
One of the basic genuine Siemens references is 6ES7901-0BF00-0AA0.
There are compatible cables available on the market. Not having the same quality or featuring the same functions (i.e. switchable termination resistors).

eWON is proposing a compatible unshielded cable:
P/N EW40912 - SUBD9/SUBD9 cable for Siemens S7, Length: 2 meter
Max baudrate is 1.5 MBit/s.
For higher baudrates use the Siemens genuine Profibus cables with resistor terminations.
## Revision history

<table>
<thead>
<tr>
<th>Revision Level</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>05/12/11</td>
<td>First issue</td>
</tr>
<tr>
<td>2.0</td>
<td>05/30/11</td>
<td>Security aspects (Appendix 2) added.</td>
</tr>
<tr>
<td>2.1</td>
<td>06/01/11</td>
<td>Automated IP config recognition</td>
</tr>
<tr>
<td>2.2</td>
<td>06/23/11</td>
<td>Plug'nRoute impact - changed 6.3 partly moved to Appendix 2, 9.3 moved to Appendix 2</td>
</tr>
</tbody>
</table>

---

Microsoft, Internet Explorer, Windows and Windows XP are either registered trademarks or trademarks of Microsoft Corporation

Firefox is a registered trademark of the Mozilla Foundation

SIMATIC® and SIMATIC Step7® are registered trademarks of Siemens.

---

Document build number: 330

---

**Note concerning the warranty and the rights of ownership:**

The information contained in this document is subject to modification without notice. The vendor and the authors of this manual are not liable for the errors it may contain, nor for their eventual consequences.

No liability or warranty, explicit or implicit, is made concerning quality, the accuracy and the correctness of the information contained in this document. In no case the manufacturer's responsibility could be called for direct, indirect, accidental or other damage occurring from any defect of the product or errors coming from this document.

The product names are mentioned in this manual for information purposes only. The trade marks and the product names or marks contained in this document are the property of their respective owners.

This document contains materials protected by the International Copyright Laws. All reproduction rights are reserved. No part of this handbook can be reproduced, transmitted or copied in any way without written consent from the manufacturer and/or the authors of this handbook.

eWON sa, Member of ACT'L Group.